User Documentation

Unified Process Management System for
Computational Fluid Dynamics (UPMS)
Dr. Khaled S. Abdol-Hamid
Shane Caldwell
Dr. Steven Massey

Input:
Grid File and
Control Files
CFD CODES

Input:
Grid File

UPMS
SOFTWARE

NEW UPMS PROJECT

CF

D

DE
CO

S

OLD UPMS PROJECT

UP
MS

PR
OJ
EC
T

Output:
Control Files

Output:
Project Files

Two Output Options

Input:
Grid File and
Project Files

TABLE OF CONTENTS

INTRODUCTION ............................................................................................. 3
DATA VIEW PANELS.................................................................................... 6
DESIGN OBJECTIVES ................................................................................. 6
DESIGN CONSTRAINTS .............................................................................. 7
Overview of system design ......................................................................................................................... 10
Performance ................................................................................................................................................ 11
Creating a New File .................................................................................................................................... 11
Loading an Existing File............................................................................................................................. 12
Conversion of file format............................................................................................................................ 12

INSTALLATION ............................................................................................ 13
TUTORIAL ...................................................................................................... 13
MENU REFERENCE .................................................................................... 13
File................................................................................................................................................................ 13
Applications................................................................................................................................................. 13
Preferences .................................................................................................................................................. 14
Tools ............................................................................................................................................................. 14

VISUALIZATION FUNCTIONS.................................................................. 14
APPLICATION REFERENCE .................................................................... 15
Main Application Window ......................................................................................................................... 15
Configurations Panels................................................................................................................................. 16
Flow BC panel ............................................................................................................................................. 16
Flow IC panel .............................................................................................................................................. 17
Solver Panel................................................................................................................................................. 18

1

Viscosity Panel............................................................................................................................................. 20
Boundary Conditions Panel ....................................................................................................................... 20
Post Panel .................................................................................................................................................... 21
Changing the Working directory............................................................................................................... 27

ISSUES WITH EXPORTING TO CFD CODES...................................... 29
PAB3D Code................................................................................................................................................ 29
TLNS3D Code ............................................................................................................................................. 29
CFL3D Code................................................................................................................................................ 30

GLOSSARY .................................................................................................... 31

2

Introduction
The Unified Process Management System was developed in conjunction with
NASA under a SBIR phase two research and development contract.
Large and small companies, research organizations and educational institutions
are increasingly using CFD codes. The Unified Process Management System (UPMS)
can provide a valuable tool for the use of NASA's CFD codes.
Each of these CFD codes has specific formats for input files. Simple
modifications in problem definition often require extensive alterations to these formats.
Often, users have to be trained by CFD code suppliers to enable them to model the
problem correctly and to use the various options available in the code efficiently. It
becomes difficult for a user to be familiar with more than one code. Therefore, the need
to develop an Intelligent System (IS) for CFD codes is being increasingly felt. To a
certain extent, some codes in the field of Computational Structural Dynamics (CSD)
provide facilities to check the grid. However, they are not supported by IS. Codes such as
MSC/PATRAN permit the creation of input files to run various analysis codes. It is this
kind of pre- and post- processor that is needed for CFD codes.
By making CFD tools more robust while also improving the accuracy and
providing physical insight to the user, the UPMS can increase the viability of CFD as a
useful design tool. Major industries that use CFD codes include aerospace, automotive,
bio-medical, electronics packaging, manufacturing, and civil engineering. Computational
efficiency is key in producing quality CFD results quickly enough to be of use to design
engineers. Often, inexperienced users unknowingly pose grossly inefficient problems due
to poor grid design and/or algorithm setup. The value of an expert UPMS is that its
detailed interface allows novice users to quickly gain experience in properly posed CFD
analysis, while under minimal supervision.
Codes such as PAB3D, CFL3D, TLNS3D, Vulcan, Overflow and others are some
of the CFD codes developed under funds and support from NASA centers. Most of the
users of a particular CFD code express the need to use another NASA’s CFD code for
comparisons or validations process. Because of the time involved in learning and setup of
the input files, another CFD code may not be utilized even if it has the right options for
simulating the particular problem. With the development of the Unified Process
Management System we will accomplish the following:
- Allow engineers to use several of NASA CFD publicly available codes.
- Speed up the technology transfer of NASA CFD code to the public, as they
become easier to use.
- Reduce the technical support for each code as users can utilize the online help
provided by the expert system.
- A universal case file can be used to generate input files for any particular CFD
code. The case file can be stored for later use or sent to another organization
or group to simulate the same problem using another CFD code.
- Build a library of standard test cases. The input library can provide the user
with direct access to a large and growing database of input codes.
- Can be used as demonstration or teaching examples or as starting point for the
novice.
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Experts may also benefit by the ability to quickly switch between different CFD codes to
obtain the best fit for the flow regime under consideration, thus minimizing design cost.

The design for the UPMS concentrates on creating an easily expandable and maintainable
program. We anticipate that many new features will be desirable in the future. Some of
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Figure 2. UPMS Master Record Structure

the interfaces may be such that their form, function, or interfaces cannot be guessed.
Consequently, we have emphasized modular interfaces and flexible architecture. The
proposed system design is illustrated in Figures 1 & 2.
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System User Interface: The system interface is composed of the workspace, screens,
pull-down menus, tool bars, context-sensitive help and online user manual. The
interface's screens uses clear, natural language descriptions, labels and instructions to
communicate with the user. The dialog boxes also provides the available choices to the
user in combo-boxes or list boxes for the user to select. Data is validated during data
entry. The expert system operates in both the UNIX/X-Window environment and
Microsoft Windows environment employing the industry standard interfaces of the Java
computer language. The expert system guides the user through the input procedure and
prevents from making improper inputs. The choice of the Java programming language
provides highly portable object oriented code. UPMS supports commonly available
graphics systems such as MS Direct-X, Unix X and OpenGL.

DATA VIEW PANELS
Data View panels present the user with a well-organized set of forms with which
to view and modify the model and it's solution parameters. The panels will be located
along the right side of the main application window, in a tabbed format, which will allow
the user to select the form from several presentations.
Data view panels are customized for the solver format mode the user is currently working
in. Information that may be relevant to one solver code will not take up screen real estate
and distract the user when working in a solver where such data is irrelevant.
A primary use of the system is to provide the user with a convenient method to
evaluate and modify the boundary conditions of the model. The primary method of
modification is the Data View panels of the main application window, described above.
In addition, the user is provided with several prepared reports, which are displayed in
dialog form. These dialogs present a list of boundary conditions which meet certain
criteria, such as adjacent face conditions which fail to be completely accounted for by the
cuts in the face, or adjacent face conditions which have no correspondent. The user may
double click on a boundary condition in the list to bring up a full display of the condition
in the associated data view panel.
The final component of the main design will be a view area, which will present
the user with a three-dimensional graphic view of the model (grid). The currently
focused boundary condition will be highlighted using color and/or a different appearance
from surrounding boundary conditions. The user will be able to rotate, pan, and zoom the
view by mouse motions over the view area in the application window.

DESIGN OBJECTIVES
The purpose of this system is to provide an easy and efficient means of modifying
CFD models. Additionally, the system will provide fast translation from/to native file
formats of several CFD Solver codes. Built in reports notify the user of any solver
constraint violations. A model visualization display is included to allow the user to
identify physical portions of the model which are being analyzed/modified.
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A principal requirement of the design is that it should be easily expanded to
support additional solvers. It should also allow the user to save an unfinished model for
later completion.

Program File Locations
All program files will be in a central directory, especially configuration files.
Configuration files will store the default conditions for unfinished models.
Project File Location
User files related to the same project will be expected to be in a single directory.
Although this directory can be changed by the user, all data files pertaining to the project
will be located in that directory.
Continuous reporting
Solver design constraint reports will be updated continuously as the user edits the
parameters, providing instant feedback as to the state of the model.
Default boundary condition assignment
Reasonable default configurations will be given to boundary conditions from newly
created projects.
Automatic patching
Initial patching of grids will be performed at creation of new projects.

DESIGN CONSTRAINTS
When converting from one file/solver format to another, Only valid conditions in the new
format are allowed. If the user attempts to export into a native format with unsupported
conditions, the software will return an error message. When converting between two
formats with different storage models, unmapped data items will either be saved for later
use in the file, or be removed altogether. Uncovered data items will be filled with default
values, which may vary depending on the current state per item. All of these are the
responsibility of the individual DataTranslator classes. Each of these classes has a
responsibility to import, export, and convert file formats from/to the native UPMS
format. If import fails, the import method displays an appropriate error message, then
throws an exception to the MainFrame. Export functions work similarly. Conversion
after load should always work smoothly, i.e. there should not be any problems if the load
did not fail.
1) PAB3D has flow codes assigned per block, and as many flow conditions as needed.
CFL3D has only one flow assignment, thus it is global (all blocks).
2) TLNS3D does not have any solver, viscosity, or flow parameters which may be
altered, but it does have additional boundary conditions not supported by PAB3D.
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3) When CFL3D is used, the following elements do not exist which exist in PAB3D:
Solver Panel:
;Global parameters
Global Iterations
CFL Scheme
;Local parameters
Integration Type
Jacobian
Viscosity Panel:
ALL TURBULENCE PARAMETERS
4) Factorization scheme in CFL3D has only the 3-factor and Scalar options, and can be
set per block, whereas PAB3D uses a global flag.
5) CFL3D adds six new fields to flow: xmc,ymc,zmc,sref, bref, and
cref. CFL3D mode does not have the ability to switch units of
measure. CFL always uses a variable type of Reynolds, and units in
English, thus temperature is given in Rankin.
6) Boundary condition options are not equivalent among all solvers.
The differences among all three are listed below
CFL3D-PAB3D:
//list all BC in CFL3D not in PAB3D, and how they should be mapped.
Singular Axis Half Plane
Singular Axis Full Plane
Singular Axis Partial Plane
Periodic in Space
Free Stream
Constant Enthalpy/Entropy
Pressure Radial Equilibrium
Pressure Sinusoidal
Specified Pressure Ratio
PAB3D-CFL3D:
Porous wall (2)
Porous wall temperature (2)
Constant wall temperature (2)
K Polar (Periodic)
I Polar (Periodic)
J Polar (Periodic)
Constant static values (2)
Constant pressure (1)
Constant pressure (2)
Constant Mach # (2)
Constant total values (1)
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TLNS3D-PAB3D:
Extrapolation (First Order)
Symmetry about X (Zero Order)
Symmetry about Y (Zero Order)
Symmetry about Z (Zero Order)
Symmetry about X (First Order)
Symmetry about Y (First Order)
Symmetry about Z (First Order)
Fan-downstream
Fan-upstream
PAB3D-TLNS3D:
Porous wall (2)
Porous wall temperature (2)
Constant wall temperature (2)
K Polar (Periodic)
I Polar (Periodic)
J Polar (Periodic)
General Symmetry
Constant static values (1)
Constant static values (2)
Constant pressure (1)
Constant pressure (2)
Constant Mach # (2)
Constant total values (2)
Farfield (2)
TLNS3D-CFL3D:
Extrapolation (First Order)
Symmetry about X (Zero Order)
Symmetry about Y (Zero Order)
Symmetry about Z (Zero Order)
Symmetry about X (First Order)
Symmetry about Y (First Order)
Symmetry about Z (First Order)
Constant total values (1)
Fan-downstream
Fan-upstream
CFL3D-TLNS3D:
General symmetry
Singular Axis Half Plane
Singular Axis Full Plane
Singular Axis Partial Plane
Periodic in Space
Constant static values (2)
Constant total values (2)
Free Stream
Constant Enthalpy/Entropy
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Pressure Radial Equilibrium
Pressure Sinusoidal
Specified Pressure Ratio
The default procedure for handling a disparity such as listed above should be to display
the value as “Not defined” in the Data View. However, the original condition should be
listed for clarity to the user in the undefined condition dialog.
7) Adjacent face conditions in PAB3D mode target the destination face. C0 conditions
exist, but assume the target face, which our process would have to calculate

On any transfer from CFL3D to PAB3D, the system should set the unmapped items to
default values. In the case of Factorization, The Global setting should be set to the
setting of the first block. (range of type is compatible). Similarly, the values of the first
flow set should be set to the implied values of CFL3D (English measure, Variable type:
Re). All blocks should be set to use the first
flow set. Finally, C0 conditions should be converted to adjacent face conditions.
Viscosity and Solver options will be set to defaults, the global Factorization scheme
should be set to the Factorization of the first block. We need not erase any of the other
factorization options, as they do no harm and can be easily recovered upon transfer back
to CFL3D mode.

Overview of system design
In order to meet the design objectives, the design is broken down into the
following class modules.
ModelDataStore
The ModelDataStore class provides storage and access in a solver independent manner to
the parameters and conditions of the model. DataReport objects (described below) are
notified of any changes to the model.
DataTranslator
The DataTranslator class is the collection of classes responsible for performing
translation from the internal model to/from native solver formats. Since each translator
only translates between a native format and the internal format, complexity is minimized
in supporting multiple solvers. A single translator class need only be aware of it’s
specific format and the UPMS internal format. For example, to translate from PAB3D to
CFL3D solvers, the PAB3D format is first converted to the internal data model, then
converted by a separate class into CFL3D format. This also promotes extensibility and
maintainability, since corrective modifications to a class affect only that class, and new
classes can be designed and added to support new solver codes.
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ModelView
The ModelView class provides the on-screen three-dimensional display of the grid and
surfaces. Display attributes such as color and solid/wireframe mode are supplied from
configuration classes. Panning, rotating and zooming of the display are controlled via the
mouse. The display can be configured to center the current block/face/cut in the view
automatically, and view angles may be saved/restored for easier navigation.
DataView
The DataView components provide the method for inspecting and editing parameters of
the model. Each DataView component displays a record of data, which the user may
edit. Boundary condition form displays summarize the scope, number of cuts, and
assigned boundary condition for each block-face. Flow form displays show initial flow
parameters assigned per block (for supporting codes), or globally (for non-supporting
codes). Solver and viscosity forms display additional viscosity and general solver
options as supported.
Performance
The following benchmarks are results of test runs on the current version of the
software. This version has not been fully optimized, and debugging traces are still
enabled. As a result, timing figures should improve in later releases.
The test system for these times a PC comprised of 256 Mbyte main memory, a
20GB hard disk, and a Pentium II processor running at 333 MHz, running under
Windows 98.
Creating a New File
The only requirement for the creation of a new file is the availability of a grid or
face file. The program will assign default values to the parameters of the model, which
the user should then edit. Creation of a new file requires the external grid to be scanned,
as summarized below.

5 Blocks
48 Blocks
75 Blocks

PAB3D
8s
32 s
310 s

CFL3D
10 s
35 s
318 s

TLNS3D
6s
28 s
305 s

The time for file creation is chiefly composed of the time required to run the
Autog3d program, which performs automatic patching of the grid. Autog3d processing
times for the grids are given in the table below (processing time is independent of solver
format).
Number of Blocks
5
48

Number of Grid Points
24,320
884,736

Processing Time
5s
25 s
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75

24,462,912

300 s

The processing time taken by Autog3d only occurs during the initial creation of a
project from a grid. Any projects created directly from existing solver files do not require
Autog3d processing, and can subtract that timing (see tables below).

Loading an Existing File
Loading a project file in the UPMS format is relatively fast, but depends
somewhat on the solver mode that the user was working in when the file was saved, as
shown in the table.

5 Blocks
48 Blocks
75 Blocks

PAB3D
5s
24 s
32 s

CFL3D
6s
27 s
52 s

TLNS3D
4s
25 s
50 s

The time required to load (import) an existing file in a native format depends on
the format, and the number of blocks in the grid.

5 Blocks
48 Blocks
75 Blocks

PAB3D
5s
7s
10 s

CFL3D
5s
10 s
18 s

TLNS3D
1s
3s
5s

During the model editing phase, the user may choose to save their work at any
time in the UPMS project format. This is the architecture-neutral format, and will allow
saving even if the model has invalid conditions. Models with invalid conditions can not
be exported, thus this is the only way to save work in progress. File save times for each
mode are shown below.

5 Blocks
48 Blocks
75 Blocks

PAB3D
1s
1s
2s

CFL3D
1s
1s
2s

TLNS3D
1s
1s
2s

Once editing is complete and the model contains no invalid conditions, the user
then chooses File|Export. The full choice of export formats is available.
Conversion of file format
File Format conversion takes place whenever a user imports, loads, or creates a
file in one mode, and attempts to convert it or export it to another.
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Direct conversion via the Solver menu takes very little time, as shown in the
following table. Direct conversion is the time required to adjust compatible fields to
allowed ranges, and determine if there are any invalid conditions.

5 Blocks
48 Blocks
75 Blocks

PAB3D to
TLNS3D
2s
6s
10 s

PAB3D to
CFL3D
5s
7s
13 s

CFL3D to
PAB3D
4s
4s
12 s

CFL3D to
TLNS3D
3s
4s
10 s

TLNS3D
to PAB3D
4s
6s
12 s

TLNS3D
to CFL3D
5s
7s
13 s

Exporting data requires both the time to perform direct conversion (shown above)
and output conversion. Output conversion times are given below.

5 Blocks
48 Blocks
75 Blocks

PAB3D
2s
11 s
30 s

CFL3D
2s
23 s
50 s

TLNS3D
2s
3s
10 s

Installation
Available in AS&M website at www.asm-usa.com/software

Tutorial
Available in AS&M website at www.asm-usa.com/software

Menu Reference
File
New Project – Create a new project file from a grid file
Load Project – Load a previously saved project
Save Project – Save the Current project
Save As – Save the current project under a different name.
Load Grid – Read the grid from an external file
Write Grid – Write the grid file
Import – Create a new project file from native solver files
Export – Save a project into native solver files. After performing the data
conversion internally, the boundary condition dialog will appear if there
are any unresolved conditions. Resolve the problems and press the “ok”
button on the main boundary condition dialog. A new dialog will prompt
you for the names of the files to save.
Close – close the current project
Exit – terminate the application
Applications
Grid Editor – Reserved for future expansion
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Pre – run Pre on the grid and display results
Auto – run Autog3d on the current grid and display results
Solver – Convert to different solver format
Post – run Post on the grid and display results
Preferences
Window Manager – Set the look and feel of the interface
Working Directory – set the current working directory
AutoSave – save the project periodically
Tools
Boundary Conditions – Display a dialog box of the general
Model Parameters – set the physical units for the grid, in meters
Display Last Pre – Display results of last Pre operation;
Active Display – Enables/Disables 3D visualization
Configure View – Control display of block structures

Visualization functions
The visualization functions of UPMS allow you to view multiple cuts, faces, at any angle
and level of focus. The visualization must be enabled, it does not appear when a model is
loaded or created. If it did, slower computers processing large grids might not be
responsive enough. To turn the visualization on, select Active Display from the Tools
menu. Selecting this menu option again will turn the display off.
ZOOM – to zoom the display, hold the left mouse button while pressing the ALT key on
windows. Move the pointer up to move the model away, and moving it down brings it
closer.
ROTATE – to rotate the display, hold the left mouse button down and move the cursor
left, right, up or down.
PAN – to pan the display, hold the right mouse button down and move the cursor left or
right.

SETTING Zoom, Rotate and Pan speeds – These factors can be set by selecting the
Model Conditions option of the Tools menu. Increasing the factor will decrease the
amount of mouse motion needed for a given amount of motion.
Display of Blocks – Blocks can be displayed or hidden using the block display dialog.
This dialog is accessed by selecting the Configure View option of the Tools menu.
Display of Cuts – cuts can be displayed by one of two mechanisms: select the cut in the
boundary panel and it becomes the focused cut, which is always displayed. The second
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method uses the boundary condition reports. If the checkmark in the column labeled
Display is selected, that cut will be displayed.

Application Reference
This manual describes in detail the UPMS interface in PAB3D mode. More PAB3D
features are currently supported and require more explanation. CFL3D and TLNS3D
modes differ from this explanation and some of these differences are noted where
appropriate. TLNS3D mode only has the boundary condition panel, and CFL3D mode
Figure 3

Title
Bar

Main
Menu

Panel
Tabs

Display
panel

Current
Panel
(Viscosity)

Action log

Status Bar

Main Application Window
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The UPMS main window is shown in Figure 3. The general elements are labeled in the
diagram. The title bar is used to move the window around on most operating systems. It
also shows the name and directory of the current project. The main menu is used to
perform actions within the program, such as loading and saving. The status bar displays
the current state of the program. Most of the time, it shows the current working directory
and the solver mode. The display panel shows a visualization of the model. To the right
of the display panel is the current panel, which is selected by clicking the mouse on the
panel tabs above it. Finally, the action log shows a running list of the actions taken by
the user during this session.
Configurations Panels

Block
Selection

Subdomain
Selection

Global
Options

Flow Set
Selection
and
configur
ation

Init to
values

Figure 4

Flow BC panel
Referring to Figure 4, the following sections are visible to us. The Block Selection
control in the top left corner controls the current block. Next to it, the Sub-domain
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selection control the current sub-domain. Below the Block Selection, The Flow Set
Selection and configuration show the currently assigned Flow Set and the values for it..
The Global Options are next to that, and are constants for all Flow Sets, blocks and subdomains. Finally, at the lower right you can see the button which will copy the Initial
flow values to this section.
The Block Selection control includes buttons to select every block, select the unselected
conditions instead (Select Opposite), and a button labeled “Save Block Options”. This
button must be pressed to save changes when multiple blocks are selected.
When multiple blocks are selected, the Flow Set does not reflect the assigned flow set of
the blocks. Instead, it shows flow set number one. Similarly, the number of sub-domains
does not reflect the number of sub-domains in every block. Instead, it shows the
minimum number of sub-domains for every block. So, if three blocks are selected, and
two have five sub-domains but the last block has only two, the sub-domain control will
only have two sub-domains to select from. Adding a sub-domain will add a new subdomain to each block, but it will be added to the end of each block’s sub-domains.
Flow IC panel
In Figure 5 we can see the Flow Initial Conditions panel, which has exactly the same
components as the Flow BC panel.
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Figure 5

Solver Panel
In Figure 6 we can see the Solver configuration panel. Take note of the following
features. The global options block at the top is used to set parameters that affect the
entire model. The Global Iterations combo box allows setting the number of passes made
at each block. The Flow Type “Set Preset” button allows you to set the block parameters
using Preset configurations. When pressed, the Presets dialog opens, as shown in Figure
7. The first four presets can only be selected, not changed. The last five can be saved,
and given descriptive titles.
As with the Flow panels, more than a single block can be configured if you wish. The
select All button will highlight every block, and changing a configuration parameter will
affected every block if the “Save Block Options” button is pressed. This button will be
highlighted in red after a change to multiple blocks, as a reminder.

Figure 6
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Figure 7

Figure 6

Figure 8
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Viscosity Panel
The Viscosity Panel, shown in Figure 8, allows you to change the viscosity settings of
each block. The Flow Type “Set Preset” button functions similar to the one on the Solver
panel. Standard configurations can be used.
Selecting the “Inviscid” option will disable the turbulence parameter block, as will
selecting any other condition when the viscous model is set to laminar.

Figure 9

Boundary Conditions Panel
The Boundary conditions panel (Figure 9) allows you to change the boundary conditions
for any cut. Note that unlike the Flow, Solver, and Viscosity panels, there is no Save
Block Options button in the Block Selection control. Instead, this button is placed at the
bottom of the panel. It highlights in red when multiple blocks are selected, as a reminder
to press it to commit changes to the blocks. The boundary condition combo box just
above it is used to assign boundary conditions to the block, face, and cut in the “source”
20

sub-panel. (Note: you will not be able to select the “Not Defined” condition, since
UPMS considers this to be an error). If you select a patched condition, the Destination
sub-panel will activate so that you may choose the connected block and face.
The source limits can be given any value, but UPMS ignores values larger than the
maximum and minimum limits of the face. The minimum value is normally one. The
maximum value is displayed in parenthesis next to the second parameter for each
direction. However, if you have exceeded the limits and try to export the model, a dialog
explaining the error is displayed, and no files will be generated. When multiple blocks
are selected, the limits cannot be changed.
When using UPMS in CFL3D mode, the selection of some boundary conditions will
replace the destination sub-panel with a group of input fields for condition parameters.
The number and names of the parameters will vary as well.
Post Panel
The Post panel, shown in Figure 10, is used to change the data, which is used by the
external Post program. The top combination is the group. You may add additional
groups or delete them. Each group will contain parameters for the blocks, shown below.

Figure 10

The ranges and steps are shown beneath that, as well as the function. The Save button in
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the lower right corner must be pressed to change these options. UPMS will not allow you
to save changes where the minimum is less than one, or where the range spanned is zero.

Figure 11

Select the Active Display option from the Tools Menu (Figure 11). The program will
spend a few moments reading the grid and building the display objects. When finished,
the Display panel will show the grid as seen in figure 11. Notice the axis display in the
lower left. This feature is not available on Windows NT. Several of the cuts have been
rendered in shades of blue, brown, and red. The colors indicate the boundary conditions
assigned to these cuts. In the figure you can see two cuts which are mirror images of
each other, but one is solid blue and the other is red mesh. These represent the currently
selected cut in the Boundary condition panel, which is a patched condition. The solid
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blue cut is the source, and the red mesh cut is the destination. The green lines show the
edges of the individual faces.

Figure 12

To list all the boundary
conditions at once, select
the Boundary Conditions
option in the Tools menu.
This will open the
Boundary Conditions
dialog shown in Figure 13.
Each button shown will
open a report or sub-dialog
Figure 13

when pressed. The number
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of cuts in each report or subgroup is shown in parenthesis above each button. Buttons
highlighted in red are critical conditions. The presence of critical conditions will prevent
any attempts to export.

Figure 14

Pressing General
conditions, or
unresolved will open
a dialog shown in
Figure 13. Three
buttons will take you
to Flow, Symmetry,
or Wall condition
reports (Figure 14).
As with the Boundary condition dialog, the numbers in parenthesis above each button
shows the number of cuts in that report.
Figure 15
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Figure 16

The Flow conditions report shown in Figure 16 displays all the Flow type cuts within the
current model. Click on the box in the Display column to view it in the Display panel.
The Select all option allows you to select every condition in the report. This is useful
when converting large numbers of cuts. To deselect any of the selected cuts, Hold down
the CTRL key and left-click that row.
When you have selected all the boundary conditions, pressing the “set” button at the
bottom will change those cuts to the currently displayed boundary condition at the bottom
center.
Pressing the Check All and UnCheck All buttons will check and uncheck the Display box
of every cut.
The columns of the reports can be resized and reordered as well. To resize them, move
the mouse cursor over the division between the column headers. When the mouse cursor
changes to a double-ended arrow, you can drag the division. To reorder the columns,
simply drag the column header left or right. The other columns will move to compensate.
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Figure 17

Figure 17 shows the Model Parameters dialog, which allows you to set the model
reference measure. Also, the Translation and Zoom factors for the Display panel can be
set here. When you select any factor from the combo box, the rate of motion for that
action will change bye the factor you have selected. Multiple selections are compounded.
So, for example, to slow down the zoom rate by one hundred times, select 0.1, then select
0.1 again. This will change the rate by 0.1 * 0.1 = 0.01.

Figure 18

Displaying blocks is performed with the Block Viewer dialog as shown in figure 18. To
open the Block Viewer dialog, select Configure View from the Tools menu. To display a
block, click on it to highlight it, and press the button labeled “Redraw”. Multiple blocks

26

can be displayed by holding down the Ctrl key when clicking on the blocks. Again, you
must press the redraw button when you have made your selection.

highlight
here

Press to
choose

Figure 19

Changing the Working directory
By default, UPMS looks in the current working directory to open project files. It is best
to use separate directories for different projects, however.
To change the working directory, select Working Directory from the Preferences menu.
The dialog in Figure 19 will open. To select your directory, you must highlight the folder
and press the Select button in the lower right corner. Do not press Select within the
directory. In other words, you should not see the directory you want to switch to in the
“Look in:” box at the top. The directory must be highlighted in the main window of the
dialog to be properly selected.
Creating a New Project
To create a new project, select the New Project option from the File menu. A dialog will
open asking for the name of the new project and the grid file. You should also choose the
default solver format for the project, and whether the grid is single or double precision.
The grid must be formatted as PLOT3D, Big-endian. Press OK, and the dialog of figure
20 will appear.
The grid file alone does not contain enough information to perform any useful function.
Solver processes additionally require information about the connectivity and physical
boundary condition to apply to individual grouping or faces of blocks. At NASA
Langley Research Center, Dr. Paul Pao developed the AutoG3d software, which with
limited information about the physical boundary condition can construct most of the
connectivity information. Also, the program can detect the location of symmetry and
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inflow/outflow locations. A dialog box will appear as shown in figure 20 to allow the
user to input more information concerning the geometrical definition for not defined
boundary conditions of the grid. At least, locations of solid surfaces should be defined to
increase the accuracy of AutoG3d software.
To skip processing by AutoG3d, press the Skip AutoG3d button. This will leave all of
your conditions set to Undefined. After AutoG3d has run or been skipped, a dialog will
appear, asking if you wish to replace the face file. A face file contains far fewer points
than the full case file, and is much smaller. It contains only points that lie directly on
faces, and only at regular intervals. This file is used when UPMS is creating the
visualization. UPMS can handle very large grids this way.

Figure 20
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Issues with Exporting to CFD Codes
This release of UPMS V1.0 does not address all the aspect of the control files for
PAB3D, CFL3D and TLNS3D. We will work with these issues in the next releases of the
UPMS.
PAB3D Code
The section starts with the section described in Code Execution Flags, Including Scale,
Timing, Trip, Etc of the PAB3D manual. The UPMS will reserve all of the variables in
this section in the case of import a project. Only rj (grid scale) is the only parameter the
user can input through the GUI. If the user starts a new project the following are the
default values for this section:
Axisymmetric Supersonic Nozzle
rj dt
iflagts
fmax isym
0.0254 -1.00 -4
5.00 2
igrid iriso inorm kg1 kg2 iperf1 jkswp impvis
11
8
1
1
5
0
0
1
ibc i2d itrp
0
0
0
ivrt istat sigl sigu gam itre
3
0
0.0 2.5 1.4 0
nprfile
0

The UPMS has no control in setting any of the following sections of the "user.cont" file
for PAB3D code:
1- Spec Cont,
2- Surf Cont,
3- Tran Cont, and
4- TimeSetp Cont
TLNS3D Code
The UPMS does only set the parameters for the boundary condition values for the
TLNS3D code. All the other parameters are set to default values:
UPMS
grdfmt fstrt fasave fplot cpplot
0.000 0.000 50.000 1.000 0.000
flev fgrids fmgtyp fstop
2.000 2.000 1.000 4.000
fcyc fcpout fcnvout
50.000 0.000 1.000
50.000 0.000 1.000
gitr(1) gitr(2) gitr(3) gitr(4) gitr(5)
1
2
2
2
2
gitp(1) gitp(2) gitp(3) gitp(4) gitp(5)
0
0
0
0
0
cflf
hmf
vis2
vis4
zeta
-6.000 0.000 0.500 1.000 0.500
c(1) c(2) c(3) c(4) c(5) c(6)
0.25 0.16667 0.375
0.5
1.0
0.0
qfil(1) qfil(2) qfil(3) qfil(4) qfil(5) qfil(6)
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-1.0
0.0 -1.0
0.0 -1.0
0.0
beta(1) beta(2) beta(3) beta(4) beta(5) beta(6)
1.0
0.0
0.56
0.0
0.44
0.0
smpmn smpmx smpmxt vepsn vepsl
cau enteps
0.010 2.500 3.500 0.300 0.300 0.000 1.000
cflc
hmc vis0 smoopic smoopjc smoopkc
2.000 0.000 6.000 0.300 0.300 0.300
rm rey\l
al
yaw
roll i2dfl
0.840 1.158 3.060 0.000 0.000 0.000
gamma
pr
prt suthc tref iturb ipatchg
1.400 1.000 1.000 0.000 460.000 2.000 0.000
xref
yref zref sref
cref scal
0.000 0.000 0.000 0.531 1.000 1.000
fprec
cfls ubmin
upk alpha delta ubfil
0.000 3.748 1.000 1.100 0.000 0.000 1.000
feng epsf
ptj
ttj
fjet ptjopfs ttjottf ttjottf mjet
0.000 0.922 1.000 1.000 0.000 1.000 1.000 0.840
CFL3D Code
The UPMS does not support moving or overlap grid. Also, the Ronie file will not be able
to handle correctly a mixed boundary condition (General and Patched) for the same face.
You should use 1-1 patching for this case. The following parameters are set to a default
values. However users can change them and import them back to the UPMS. For the
main control file:
DT IREST IFLAGTS FMAX IUNST CFLTAU
-5.0000
0
0
1.0000
0 10.0000
NPRINT NWREST ICHK NTSTEP ITA
0
100
0
0
1
MGFLAG ICONSF
MTT NGAM
1
0
0
2
ISSC EPSSSC(1) EPSSSC(2) EPSSSC(3) ISSR EPSSSR(1) EPSSSR(2) EPSSSR(3)
0
0.3
0.3
0.3
0
0.3
0.3
0.3
For all the Blocks
IEM IADVANCE IFORCE
0
0
333
ILAMLO ILAMHI JLAMLO JLAMHI KLAMLO KLAMHI
0
0
0
0
0
0
INEWG IGRIDC IS JS KS IE JE KE
0
0
0
0
0
0
0
0
NPLOT3D will always set to the number for blocks with a full range specified for each
block.
For the case of Ronnie file:
ronnie.out
patch.bin
IOFLAG ITRACE
1 -1
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title here
and, for each block:
IIFIT LLIMIT IITMAX MMCXIE MMCETA
1
1
100
0
0

IICO IIORPH
0
0

GLOSSARY
Block – a logically related subset of points in a grid.
Boundary condition – The parameter assigned to a cut to
Cut – sometimes called a segment, this is a subset of the points on a Face.
Export – to save the model data in a format that an external program can read and write.
Face – a single face of a six-sided block. Faces do not need to be planes or even
quadrilaterals.
Flow Set – the entire group of parameters which are used to describe a flow model. Flow
Sets may be the same for an initial flow and a steady flow, but they are not required to be
so.
Grid – A collection of points in three dimensional space and the connections between
these points. A grid is normally broken down into segments of fixed size, called block or
zones.
Import – to read a file generated by an independent external program.
Model – a grid (see above) along with the Flow Sets, solver parameters, and all other
parameters relating to the CFD configuration.
Open Face – a state in which the cuts defined on a face do not span the entire face.
Although no single cut must necessarily cover the face, all the cuts must do so as a group.
Undefined Condition – a cut that does not have a valid boundary condition assigned to it.
Unmatched Pair – a state in which a patched condition does not have a corresponding
connection in the destination face. The destination of a source must also have a condition
with the first source as destination.
Zone – see Block

31

